Design Basics

The design process requires many skills. Perhaps the most important is the ability to sketch and annotate a conceptual design. This skill applies to all engineering disciplines: architecture, civil, and mechanical.

This unit focuses on sketching tools, such as visualization, annotation, 2D and 3D sketches.

Content

- Unit 1 - Design Overview
- Unit 2 – AutoCAD Basics
- Unit 2 - Sketching and Annotation
Unit 1 - Design Overview

Introduction

Design encompasses everything man-made. Applied design, and the systematic application of the principles of design, is the basis behind teaching and using technology.

Technological design includes these areas:

- Architectural design (buildings, interior design, urban planning)
- Civil design (bridges, highways, dams)
- Electronic design (hardware, software engineering)
- Industrial design (mechanical, manufacturing, fashion, engineering)
- Graphic design (advertising, film, other media)

About this Unit

This unit provides a brief overview of the design process and principles.

Standards

This lesson meets standards for Science Content, Math, Language Arts, and Technology.

Lessons

- Introduction to the Design Process
- The Project Problem Solving Model
- Overview of Design Principles
Lesson 1 - Introduction to the Design Process

Design is the broad-based integration of art and engineering. It combines the study of science, language, math, business, and society. Applied design and the systematic application of its principles are the basis behind using and teaching technological design.

Today’s educator must travel beyond the confines of the classroom to teach real-world learning. Teachers know they must bridge the gap between concept and application. They must teach more than just drafting in order to prepare their students for the real world of industry. They must teach the complete design process: drafting, problem solving, testing, presentation, production, and post-production.

How to Begin Teaching the Design Process

Design is an all-encompassing subject area with no real experts, just informed and talented individuals. Here are some points to remember about teaching the design process:

- Design is subjective. Teach your students how to rationalize and critique.
- Many technology educators think that drafting is design. Drafting is just one component of design, one tool in the process of designing. It is one of the last steps before manufacturing, not the first. Teaching drafting first is like teaching calculus before addition and subtraction.
- The design project must be relevant to the student’s needs and experience.
- The design project must be significant; it must have a purpose and never be treated as make-work time filler.
- Ask students to consider the design of everyday articles in their home such as toys, tools, and utensils. Does the design work or not? Can they improve it? How was the item manufactured?
- Limit the variables. Providing constraints to the project allows more room for creativity.
- Students cannot design in a vacuum. They need to see what was done before, what the rationale is, and what their experience gives them.
- Avoid the tendency some students have to throw everything into the design. Simple is better.
- Encourage students to create a solution with an explanation.

The Design Brief

Create a design brief, or a short description, of the problem you want your students to solve. A good design brief includes background, tasks to perform, the deliverables, such as reports, sketches, models and illustrations, and a time line. Have them record everything, and throw nothing away.

Here are the important skills that students must ultimately learn and develop to understand the design process:

- Research
- Problem-solving
- Team work
Solution-oriented design

Above all else, design fulfills a need. It begins with identifying a problem or a need and figuring out how to create a solution.

- Find ways to remove barriers to creativity, such as speed sketching and word associations.
- Teach your students that logical design processes should not supersede creativity, and that taking risks and failure is good. This is a learning process and is not to be feared.
- You must build enthusiasm and excitement from the beginning.
- Do not expect students to sit still and sketch and draw and draft endlessly at the beginning of the project.
- Do not expect three or five or ten ideas, but do expect at least one.
- Studies show designers work best with one idea, and then will work on others if the first one doesn't fly.
Lesson 2 - Project Problem-Solving Model

Every source on teaching design has a graph, chart, or step-by-step directions to describe how to go about designing a product.

A project problem-solving model is outlined below:

**Planning Stage**

**Problem Identification**

- What is the problem?
- Why are you trying to solve it?
- Research.
- Conceptualize possible solutions.
- Brainstorm with team mates.
- Block out solutions, thumbnails, and models

**Set Goals and Note Criteria**

- How?
- When?
- Consider resources, materials, funds, and time constraints.
- Discuss goals with clients, users, and investors.
- Refine solutions, use more thumbnails and models.

**Evaluate, Test, Select, and Implement Solutions**

- Brainstorm, sketch, doodle, thumbnails, roughs, models.
- Group discussions, decisions.
- Pin down solution.
- Opinions to other stages.

**Presentation Stage**

**Sell the Solution**

- Polish, and layout solution(s), completed drawings.
- Present ideas to management, clients, and investors.
- Opinions to other stages.

**Production Stage**

**Manufacture**

- Complete engineering design and prototypes.
- Evaluate process, verify, and then modify if necessary.
- Monitor production.
• Opinions to other stages.

**Post-Production Stage**

**Evaluate**

• Analyze and conclude, and then report results.
• Refine ideas for further work.
• Opinions to other stages.

**Teaching the design process may involve the following paradigms:**

• Concept: Student comes up with an idea.
• Design: Select the software that best allows for the model and the discipline.
• Document: Drafting, rendering, animation, and technical writing.
• Building: Machining, CNC, carpentry, woodworking, or welding.
• Use: Application.

Some of the above information is excerpted with permission from a web page authored by Michael Scott, 1997.
Lesson 3 - Overview of Design Principles

Prior to beginning the design process, there are basic concepts and terms that will assist you in understanding what creates a good design.

Terms are not always going to be visible or obvious. Being able to justify why certain theories were or were not applied or implemented is necessary in determining what encompasses a good design.

The following are basic terms to understanding any design. More than one term may apply to any design.

**Note:** The images shown below are available as AutoCAD DWG files. They are located in the Data Files\Design Basics\Unit 1 - Design Overview folder.

**Axis** - A straight, imaginary line that follows the width, height, or depth of an object.

The names of these axes are:

- x-axis for width
- y-axis for height or length
- z-axis for depth
You create an axis through the center of the entrance.

In the floor plan, a path shows the traffic flow into the bedrooms and living area.
In the concrete block, the axis shows two directions: the X and Y axes.

*Scale* - A proportion between two sets of dimensions (as between those of a drawing and its original). On a drawing, you select a standard scale to create an object full size, smaller, or larger than the object it represents.

Note that the information does not change the actual size of the object.

*Line* - The path between two points. Lines can also define object boundaries.
**Dimensioning** - Another name for the size description of an object.

The floor plan and concrete block display how you dimension objects in order to construct them.
*Composition* - The arrangement, style, and size of words or lines on a drawing.

In a floor plan, you arrange rooms in three categories: sleeping, living, and service. Having a balance of each area forms a good composition.

*Form/Fit/Function* - Answers the three questions:

- Form - does the shape appeal to the space?
- Fit - is the size appropriate to the space?
- Function - does the object serve its purpose?

Answering these three questions will justify if the design is well planned.

*Symmetry* - Mirrored or balanced around an axis; an object in which one side is an exact mirror image of the other.

The entrance is symmetrical: it is exactly the same on both sides of the axis.
The concrete block is also symmetrical about the axis.

*Balance* - Two objects or areas that have a sense of equality.

The spaces may have a different shape but the arrangement of the shapes creates a sense of equality.

*Rhythm* - A pattern of measured motion that flows.

The columns create the flow to illustrate rhythm and repetition.
Proportion - Size relative to the other objects in the same drawing.

The opening of the entrance is relative to the height of the structure.

You have just reviewed the basic concepts and terms you will need to understand in order to create a good design.
Unit 2 - AutoCAD Basics

Introduction

The Sketching and Annotation, Pre-Civil, and Pre-Architectural units use AutoCAD or AutoCAD based applications. To ensure that you have the prerequisite basic skills to use these applications a series of introductory exercises are provided. The objectives of the exercises are as follows:

- Navigate the AutoCAD graphic environment, zooming and panning to view objects, using the command window, the help system, and exploring environment settings and function keys.
- Configure fundamental drawing settings and options such as scale, grid, snap, object snap, file paths, and display colors.
- Create basic AutoCAD objects such as lines, polylines, circles, arcs, and polygons using menus, palettes, keyboard commands, mouse controls, coordinates, and object snaps.
- Modify AutoCAD objects using multiple techniques including grip editing and object properties.
- User layers to control object settings.
- Navigate and view objects in 3D.
- Create reusable internal blocks and world blocks.
- Use externally referenced drawings in the current drawing.
- Draw objects in paper space (layouts) and configure one or more viewports in a layout.
- Create a properly formatted layout with required map elements such as a title block, north arrow, border, and scale.
- Configure the page setup and plot layouts to an engineering scale.

Installing AutoCAD

It is recommended that you install AutoCAD Civil 3D 2008 and use the Civil 3D as AutoCAD 2008 option. This provides a basic AutoCAD environment.

AutoCAD Basics Learning Material

The AutoCAD Basics material is provided in PDF format. To view the content, open AutoCAD Basics.pdf from the Printable Lessons folder.
Unit 3 - Sketching and Annotation

Introduction

Sketching and annotation are vital in the design process. Without the ability to visualize a product or idea before it is created can seriously jeopardize research and design, as well as production.

Annotation is also an important aspect of the design process. Sketches would have little meaning to the manufacturer and could not be read or interpreted correctly without annotation or written communication. They would provide a visual awareness without a clear intent of the design.

The key to developing any good product is to start with a good idea and follow the design process.

Sketching is the way we visually communicate ideas to others. It allows the student to have an awareness of the product at the point of its conception without having to spend vast amounts of time for research and development. Sketching is the conception phase, where ideas are developed for research and design to begin. Without ideas on paper, many of the products you use would not have been developed.

About this Unit

You sketch your designs on paper, and then use AutoCAD® to draw them to complete the design process.

Your focus is on developing sketching and annotation techniques as they progress to the drawing environment.

Students do not have to know how to sketch or use a computer to be successful in these lessons.
Lessons

- Sketching Tools and Techniques
- 2D Representation
- 3D Representation
- Word Processing
Lesson 1 - Sketching Tools and Techniques

You will learn how to sketch in all three dimensions using pencil on paper, and eventually you will use AutoCAD.

You should expect to learn the tools and techniques of sketching with a pencil on paper. You will learn how to approach sketching and annotating in a conceptual way by developing the ability to visualize objects spatially, and by understanding the different views of an object. You will be able to communicate your ideas on paper through the process of sketching. Sketching is the process or beginning of design.

Preparation

To view objects in 3D, Autodesk Inventor® Professional must be installed.

You also need Adobe® Reader® to view PDF files. It is supplied on the ADA product CD or it can be downloaded at www.adobe.com.

Exercises

Review the Sketching Tools

- Measurement and Proportion
• Visualization and Linetypes
• Hidden Lines
• Dimensioning and Annotation

**Use Various Techniques to Sketch**

• Conceptual Design and Rough Sketching
• Orthographic Sketching
• Isometric Sketching

**Standards**

This lesson meets standards for Science Content, Math, Language Arts, and Technology.

**Key Terms**

<table>
<thead>
<tr>
<th>accuracy</th>
<th>diameter</th>
<th>note block or general notes</th>
<th>size</th>
</tr>
</thead>
<tbody>
<tr>
<td>aligned</td>
<td>dimension line</td>
<td>notes</td>
<td></td>
</tr>
<tr>
<td>annotating</td>
<td>dimensioning</td>
<td>object line</td>
<td></td>
</tr>
<tr>
<td>ANSI/ASME</td>
<td>drawing area</td>
<td>orthographic projection</td>
<td></td>
</tr>
<tr>
<td>Standards</td>
<td></td>
<td>tolerancing</td>
<td></td>
</tr>
<tr>
<td>arrowhead</td>
<td>extension line</td>
<td>phantom line</td>
<td></td>
</tr>
<tr>
<td>block</td>
<td>faces</td>
<td>polygons</td>
<td></td>
</tr>
<tr>
<td>border</td>
<td>hidden line</td>
<td>proportion</td>
<td></td>
</tr>
<tr>
<td>break line</td>
<td>isometric</td>
<td>radius</td>
<td></td>
</tr>
<tr>
<td>centerline</td>
<td>leader</td>
<td>revision block</td>
<td></td>
</tr>
<tr>
<td>conceptual design</td>
<td>linetype</td>
<td>scale</td>
<td></td>
</tr>
<tr>
<td>construction line</td>
<td>microfilm centering arrow</td>
<td>section lines</td>
<td>zone lettering/numbers</td>
</tr>
<tr>
<td>cutting</td>
<td>multiview drawing</td>
<td>sheet</td>
<td></td>
</tr>
</tbody>
</table>

**Evaluation**

You evaluate students on the completion of the exercises and a production drawing.

**Resources**

Exercises
Grid Paper
Isometric Paper
**Procedure**

1. Demonstrate opening a part in Autodesk Inventor. (Instructor)

2. Demonstrate the Rotate and Look At tools in Autodesk Inventor. (Instructor)

3. Start by Completing Exercises - Review the sketching tools. (Student)

4. Start with a new idea for a part or product. (Student)

5. Complete Exercise - Use various techniques to sketch. (Student)
Exercise 1 - Measurement and Proportion

Throughout a project the sketches must be accurate and in proportion. Accuracy in sketching requires knowledge of reading a scale.

The purpose of this exercise is to understand scale and how to apply proportion in your sketches. A ruler, an architect's scale, and an engineering scale are the required tools.

Supplies for this exercise include:

- Pencil
- Ruler
- Architect's scale
- Engineering scale

Reading a ruler

1. Compare a ruler to a pizza that is divided into 12 slices. The pizza has 12 slices; a ruler has 12 inches (12”).

Remember:

- The ” sign represents inches.
- The ' sign represents feet.
2. One slice of pizza is like one inch on a ruler. If you cut the slice, and the inch, in half, you have two half slices and two half inches.

3. If you cut the two halves in half again, you then have four quarter slices and four quarter inches.

The illustrations below show the continued process of cutting the pizza and the inch in half.
\[ \frac{1}{8} + \frac{1}{8} + \frac{1}{8} + \frac{1}{8} + \frac{1}{8} + \frac{1}{8} + \frac{1}{8} + \frac{1}{8} + \frac{1}{8} = 1 \text{ slice and } 1" \]

\[ \frac{1}{16} + \frac{1}{16} + \frac{1}{16} + \frac{1}{16} + \frac{1}{16} + \frac{1}{16} + \frac{1}{16} + \frac{1}{16} + \frac{1}{16} + \frac{1}{16} = 1 \text{ slice and } 1" \]
Notice as we keep slicing the pizza or inch in half, the denominator is multiplied by 2.

4. To read a ruler, count how many whole numbers there are to the left of what you are measuring, starting at zero.

In this example the whole number is 4. Observe the whole number between 4 and 5 to recognize what the smallest unit is. It is a quarter unit (1/4).

You then count how many units there are starting from the whole number 4. Finally you add the whole number to the part and the answer is 4 3/4”.

5. Try it again. The whole number is 3. The smallest unit from 3 to 4 inches is eight’s (1/8). The answer is 3 5/8”.
6. Try it again. The whole number is 1. The smallest unit between 1 and 2 are sixteenths (1/16). There are 13/16 after counting, so the answer is 1 13/16".

7. Try it again. The whole number is 0. The units are 1/32's and there are 31/32's. The answer is 31/32".

8. Open RULER.pdf and complete the exercise.

Have your instructor evaluate your understanding of reading a ruler.

In this exercise, you learned to read a ruler and you reviewed fractions.
**Reading a scale**

In the sketching process, drawings are reduced or enlarged to better visualize your ideas. You use scale to better understand the process of reducing and enlarging.

In this exercise, you learn to read a scale and understand how reducing and enlarging objects represents their full size.

Open SCALE_CHART.pdf.

<table>
<thead>
<tr>
<th>ARCHITECT SCALE</th>
<th>ENGINEERING SCALE</th>
</tr>
</thead>
<tbody>
<tr>
<td>2&quot; = 1'-0&quot;</td>
<td>DOUBLE SIZE = 2&quot;:1&quot; DOUBLE SCALE 2:1</td>
</tr>
<tr>
<td>1&quot; = 1'-0&quot;</td>
<td>FULL SIZE = 1&quot;:1&quot; FULL SCALE 1:1</td>
</tr>
<tr>
<td>½&quot; = 1'-0&quot;</td>
<td>HALF SIZE = ½&quot;:1&quot; HALF SCALE 1:2</td>
</tr>
<tr>
<td>⅛&quot; = 1'-0&quot;</td>
<td>QUARTER SIZE = ⅛&quot;:1&quot; QUARTER SCALE 1:4</td>
</tr>
<tr>
<td>⅛&quot; = 1'-0&quot;</td>
<td>EIGHTH SIZE = ⅛&quot;:1&quot; EIGHTH SCALE 1:8</td>
</tr>
<tr>
<td>⅛&quot; = 1'-0&quot;</td>
<td>SIXTEENTH SIZE = ⅛&quot;:1&quot; SIXTEENTH SCALE 1:16</td>
</tr>
</tbody>
</table>

**Understanding scale and proportion**

1. Drawings at full size may not fit on a piece of paper. To make drawings manageable, you rely on reducing the drawing size. In reduction, it is vital that the drawing represents the part accurately. You rely on scale to do this.

For example, if a part is 1' long, to fit it on a piece of paper we can reduce its size so every 1" on the drawing = 2" of the part. The part is now represented at half size.

Remember:
- ' represents foot
- " represents inches
2. In looking at architect and engineering scales, you see that from double scale to sixteenth scale the units reduce in half, getting progressively smaller, much like a ruler.

<table>
<thead>
<tr>
<th>ARCHITECT SCALE</th>
<th>DOUBLE SIZE</th>
<th>FULL SIZE</th>
<th>HALF SIZE</th>
<th>QUARTER SIZE</th>
<th>EIGHTH SIZE</th>
<th>SIXTEENTH SIZE</th>
<th>TWELFTH SIZE</th>
<th>TENTH SIZE</th>
</tr>
</thead>
<tbody>
<tr>
<td>2’ = 1’ – 0”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1’ = 1’ – 0”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6” = 1’ – 0”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3” = 1’ – 0”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.5” = 1’ – 0”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.75” = 1’ – 0”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.1” = 1’ – 0”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.12” = 1’ – 0”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ENGINEERING SCALE</th>
<th>DOUBLE SCALE</th>
<th>2:1</th>
<th>FULL SCALE</th>
<th>1:1</th>
<th>HALF SCALE</th>
<th>1:2</th>
<th>QUARTER SCALE</th>
<th>1:4</th>
<th>EIGHTH SCALE</th>
<th>1:8</th>
<th>SIXTEENTH SCALE</th>
<th>1:16</th>
<th>TWELFTH SCALE</th>
<th>1:12</th>
<th>TENTH SCALE</th>
<th>1:10</th>
</tr>
</thead>
<tbody>
<tr>
<td>2”=1”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1”=1”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>½”=1”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>¼”=1”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/8”=1”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/16”=1”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/12”=1”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/10”=1”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Half scale is proportionally reduced in size (Length, Width, Height). It is only 1/2 proportional to full size, but not in volume or area.

**Note:** Do not get confused between size, volume, and area. 1/2 the size is actually 1/8th the volume of a solid and 1/4 the area of a polygon.

Conceptually you visualize three dimensions (Length, Width, Height) for solids and two dimensions (Length and Width) for polygons. Size is proportional as shown below.
4. Proportion is the relation of one part to another or the whole. In this exercise, that relationship is scale.

Reading architectural and engineering scales

1. Architectural and mechanical engineering scales are similar. In this example, scale represents 1/2 in units.

   - A half inch mechanical engineering scale is described as 1/2"=1".
   - A half inch architectural scale is described as 1/2"=1'-0", which is 1/24 scale (24 half inches in a foot).

Each scale represents 1/2" units, one representing inches and the other feet.
2. Use the architectural scale, and then the engineering scale to consider measuring a part.

**ARCHITECT SCALE**

- The part measures over 2 plus an additional amount.
- On the architect scale of \( \frac{1}{2}'' = 1'-0'' \), 2 represents 2'.
- You measure the additional amount by placing the end of the object on the whole number (in this case 2), and then measure from 0 to the left.
• The measurement to the left of 0 represents the scale of one unit in its entirety. In this example, it is 1/2 of an inch. It is divided into 12 representing a foot or 12".

**Note:** Depending upon the scale, you divide the units before 0 in 6, 12, or 24.

• According to the scale of 1/2"= 1'-0" when you count from 0 to the left the additional amount is 7".

• The answer follows the same format as 1'-0" and is the sum of the two parts: 2'-7".

**ENGINEERING SCALE**

• The engineering scale represents 1/2"= 1". The part measures 2 plus an additional amount. On the engineering scale of 1/2"= 1", 2 represents 2 inches. You read from the 0 to the left just like the architectural scale to measure the additional amount.

• The units to the left of 0 are divided into 16 instead of 12.

**Note:** Depending upon the scale, the units before 0 could be divided in 8, 16, or 32 units.

• You count from 0 to the left and the additional amount is 9. Since it is out of one inch, 9 represents part of an inch, or, 9/16".

• The answer follows the same format as 1" and is the sum of the two parts: 4 9/16".
3. Open *SCALE.pdf* and complete the exercise.

Have your instructor evaluate your understanding.

In this exercise, you learned how to read an architect scale and an engineering scale.
Exercise 2 - Visualization and Linetypes

Before you begin to sketch, you must understand how to represent 3D objects on paper as 2D objects.

You use sketching to visually communicate your ideas on paper to others.

Every object has faces, sides, and views. In this exercise, you will learn the difference between them by looking at 3D geometry and drawing their different views.

Supplies required for this exercise:

- Open GRID.pdf or obtain a sketchbook.
- Pencil
- Scale
To visualize an object

Note: Refer to Change the Active Project before you start this exercise.

1. Open `Die.ipt`.

2. On the Standard toolbar, click Rotate. Rotate the die in all directions to view its sides.

3. All 3D objects have sides. If you put any object into a clear plastic box, it would appear to have six sides just like the clear plastic box.

   These sides are called views. There are six views to any object: top, front, back, bottom, right-side, and left-side.
4. Press ESC to turn off Rotate. Move the cursor over the object and note that it has many faces, not just six.

Faces are different from sides. They are polygons, and when covered, are named surfaces. Each face is a plane in space and is represented by connecting lines or vectors.
5. On the Standard toolbar, click Wireframe Display. Connecting lines and vectors are viewed forming polygons. There are exactly eighty-nine (89) polygons which represent eighty-nine (89) faces as a solid.

6. Close the file. Do not save changes.

In this exercise, you learned that every object has faces, sides, and views.

**Create six views of an object**

In this next exercise, you look at a variety of objects and interpret each of its six views by sketching.
1. There are six views:
   - Top
   - Front
   - Bottom
   - Back
   - Right-side
   - Left-side

2. As you unfold the box, each view is in relationship to the other. Use the faint white construction lines to create one view, and then use them to help create subsequent views.

The front view is always in the middle with the other views arranged out from it. By identifying the front view of an object, you can then identify the other five views.
Identifying the views of a 3D or solid object is the beginning of sketching. You visualize what the object looks like in 3D, or as a solid, and then visualize its different views so that a set of plans can be created and eventually manufactured.

3. Try the visualization sketching process. Each object exercise in this lesson opens up to a 3/4 view:

- Top
- Front
- Right-side

Once open, identify the front view. It is always the view to the left, as shown below.

4. After you identify the front view of the object, sketch on a piece of sketch or graph paper the front view with the other views arranged around it as shown below using the die as an example.

- Open Die.ipt.
- On the Standard Toolbar, click Rotate.
• Press the SPACEBAR to display the Common View tool.

• Click the front green direction arrow (turns red when selected) to reorient the view. This is the front view of the die.

• Continue with this process until all six views are displayed and you have drawn them.
Complete the following exercises using Autodesk Inventor to assist in visualizing the objects. Remember to use your scale and grid paper.

**Visualization and sketching exercises**

**Note:** Refer to Change the Active Project before you start this exercise.

- Open *Part1.ipt*
- Open *Part2.ipt*
- Open *Part3.ipt*
- Open *Part4.ipt*
- Open *Part5.ip*
- Open *Part6.ipt*
- Open *Part7.ipt*
- Open *Part8.ipt*

In this exercise, you learned that every object has six views and you created sketches of each object.
Exercise 3 - Hidden Lines

You now understand how to draw all six views of an object, but you still need to understand how to represent hidden parts of the object.

Supplies required for this exercise:

- Open GRID.pdf or obtain a sketchbook.
- Pencil
- Scale
To sketch hidden lines

1. Objects, like the button shown below, have parts cut away from them. The button has four holes, the top is recessed, and the button's top edges are round.

![Button Image]

2. A sketch of the bottom side of this object would appear as shown below.

![Bottom Side Sketch]

3. In this example, only object lines are represented. You represent the holes and cutaway parts in the object with hidden lines.

*Hidden lines* are dashed lines with 0.125" dashes and 0.0625" spaces to represent the cutaway from the object. You draw hidden lines 0.4 mm thick.

![Hidden Line Diagram]
4. Add hidden lines to represent the recessed part of the object. The hidden lines follow the rounded part inside the object, as well as the recessed part.

5. Add hidden lines to represent the four holes. The hidden lines intersect the hidden line representing the recessed part of the button.

The bottom view is now complete.

**Note:** Hidden lines do not have a space at the intersection with an object line. Hidden line dashes should touch the object line or another hidden line.

**Add hidden lines to the sketches**

1. Add hidden lines to the sketches you completed in the previous exercise. Remember to use your scale and grid paper.

For these exercises, use the American National Standards Institute (ANSI/ASME) standards. ANSI standards recommend two line thicknesses, 0.6 mm for thick lines and 0.3 mm for thin lines, but the actual width of lines can be more or less. Companies vary in their lineweight, as you will for these exercises.
2. Save your work for future lessons.

In this exercise, you learned that cutaway parts of an object are represented by hidden lines.

**Other linetypes**

With different linetypes, you have a common visual language to communicate by.

In this exercise, you learn the different linetypes and how you use them in a drawing.

1. Use *construction lines* to aid in the drawing of other views. You use object lines to define the object with a 0.6 mm thickness. You use hidden lines to draw cutaway parts of an object with 0.6 mm thickness.
• CONSTRUCTION LINE - hardly visible continuous line
• OBJECT LINE - 0.6 mm continuous line
• HIDDEN LINE -
  o 0.4 mm line width
  o 0.125" dashes
  o 0.0625" spaces
  o meet or cross object lines

In addition to construction, object, and hidden lines, other linetypes are used to improve the understanding of drawings:

For these exercises, use American National Standards Institute (ANSI) standards. All linetypes have specific lengths for dashes and spaces.

2. Use center lines to identify the center of a circle, arc, or other symmetrical feature.
Center lines have center dashes about 0.125" long and spaces 0.0625" in length.

The length of the long dash is about 0.75" to 1.5" in length.

Center lines extend 0.25" outside the object lines if needed. The center line thickness is 0.3 mm.

**ANSI/ASME Y14.2M—1992 LINE CONVENTIONS AND LETTERING STANDARDS**

- CENTER LINE
  - 0.3 mm line width
  - 0.125" short center dashes
  - 0.0625" spaces
  - 0.75" to 1.5" long dashes
  - 0.25" extension, when needed

3. Use *phantom lines* to show alternative positions of moving parts.

Phantom lines are 0.3 mm in thickness and you use them in place of object lines.

They have center dashes about 0.125" long and spaces 0.0625" in length. The length of the long dash is about 0.75" to 1.5" in length.
ANSI/ASME Y14.2M—1992 LINE CONVENTIONS AND LETTERING STANDARDS

- PHANTOM LINE
  - 0.3 mm line width
  - 0.125" dashes
  - 0.0625" spaces
  - 0.75" to 1.5" long dashes

4. Use viewing-plane lines to identify a view enlargement or for a partial view of an object.

Viewing-plane lines are 0.6 mm in thickness and are 0.25" with an arrowhead outside of the view. Both ends of the lines have arrowheads that are 0.3 mm long and 0.1 mm high.

You position them directly across from each other in the view. They are also labeled to correspond with the labeled view.
ANSI/ASME Y14.2M—1992 LINE CONVENTIONS AND LETTERING STANDARDS

- VIEWING-PLANE LINE
  - 0.6 mm line width
  - 0.25" extension with arrowhead
  - 0.3 mm length and 0.1 mm width for arrow

5. Use cutting-planes to identify a sectional view of a part. A sectional view is a cross section of a part. Sectional lines are 0.3 mm in thickness and are spaced parallel at 0.125" apart at 45°.

Cutting-plane lines have center dashes about 0.125" long and spaces 0.0625" in length.

The length of the long dash is about 0.75" to 1.5" in length. They are 0.7 mm in thickness and lines are 0.25" to 0.5" with an arrowhead outside of the view.

Both ends of the lines have arrowheads that are .3 mm long and 0.1 mm high. You position them directly across from each other in the view. You label them to correspond with the labeled view.
ANSI/ASME Y14.2M—1992 LINE CONVENTIONS AND LETTERING STANDARDS

- **CUTTING-PLANE LINE**
  - 0.6 mm line width
  - 0.125” dashes
  - 0.0625” spaces
  - 0.75” to 1.5” long dashes
  - 0.25” extension with arrowhead
  - 0.3 mm length and 0.1 mm width for arrow

- **SECTION LINE**
  - 0.3 mm line width
  - spaced parallel
  - at 45°

6. Use a *break line* to represent part of a view. Break lines can be short and long.

A short break line is a sketchy 0.6 mm wide line to indicate the break in the view.

A long break is a continuous 0.3 mm line accompanied by two zigzag's at 0.125" high and 60°. The long break line extends 0.25".
ANSI/ASME Y14.2M—1992 LINE CONVENTIONS AND LETTERING STANDARDS

- **BREAK SHORT LINE** - 0.6 mm sketchy continuous line
- **BREAK LONG LINE** -
  - 0.3 mm line width
  - 2 zigzag's at 0.125" dashes and 60°
  - extending at 0.25"

7. You must remember that it is the continuous *border line* at 0.8 mm, that presents all of the views, dimensioning, and annotations. Dimensioning and annotation will be discussed in the next lessons.

ANSI/ASME Y14.2M—1992 LINE CONVENTIONS AND LETTERING STANDARDS

- **BORDER LINE**
  - 0.8 mm continuous

8. You can now add additional linetypes to the sketches from the previous exercises. Remember to use your scale and grid paper.

In this exercise, you learned about linetypes and how to apply ANSI standards.
Exercise 4 - Dimensioning and Annotation

Drawings must have annotations, measurements, identification, and notes.

In this exercise, you learn how to dimension your sketches, create title blocks, and add notes.

1. Indent views with measurements in order to manufacture the part.

Dimensioning gives your drawings length, height, and width. You position them horizontally or vertically. Numbers and text should be 0.125" high; all uppercase block letters.
For these exercises, you use the American National Standards Institute and the American Society of Mechanical Engineers (ANSI/ASME) Y14.5M—1994 standards.

Although the "M" stands for metric, these are the standards which all dimensioning and tolerancing practices stem from. Standards are a set of rules that the industry follows.

**ANSI/ASME Y14.5M—1994 DIMENSIONING AND TOLERANCING STANDARDS**

- **DIMENSION LINE**
  - 0.3 mm line width, continuous line
  - first line spaced 0.375" to 1" from view
  - additional lines spaced at least 0.25" apart
  - numerals are 0.125" high

- **EXTENSION LINE**
  - 0.3 mm line width
  - extends from arrow 0.125"

- **ARROWHEADS**
  - 0.3 mm line width
  - 0.125" length
  - width is 1/3 of its length

- **LEADERS**
  - 0.3 mm line width
  - 0.125" horizontal bar length
  - 45º to 60º
  - numerals and text are 0.125" high

2. Dimensioning is extension, dimension, and leader lines with arrowheads at a 0.3 mm width.

*Dimension lines* must be at least 0.375" to 1" away from the view. They can be chained together and stacked with at least 0.25" apart from the previous one as shown below.

Dimension line arrows are 3 units long and 1 unit wide. The standard length is 0.125". *Extension lines* extend from the view with a 0.6" or 1/16" gap.
3. *Leaders* are 0.3 mm wide lines that lead from the view or feature with a note or measurement. Leaders terminate with an arrowhead touching the view. Leaders are 45° to 60° and have a horizontal bar at 0.125”.

4. In dimensioning, you use arcs, circles, and leaders.
5. Use leaders or follow the angular method below to dimension angles.

6. Your mechanical drawings should be unidirectional where all numerals, figures, and notes are written horizontally to be read from the bottom of the sheet.

   Architects use aligned dimensioning so that they may be read from the bottom and right side.

7. Features in drawings should not be dimensioned twice. If dimensioned in one view, the other view does not need the feature dimensioned.
8. Accuracy is important in drawings. All dimensions should represent full scale. If your drawing is half scale and measures 1.000 in length, then the dimensioning text will be 2.000.
9. Open and print DIMENSION.pdf, and then complete the exercise by finishing the dimensions and correcting any dimensioning errors.

Have your instructor evaluate your understanding. For additional practice, dimension your drawings from the previous exercises.

**Tolerancing**

1. If you have a hole with a shaft to fit into it, the shaft and the hole cannot be the same size.

If we make the shaft smaller than the hole, the shaft will fit into the hole. This is tolerancing. It is a variable amount that permits parts to fit together.

2. Tolerancing can be included in the dimension or included in a title block. As shown below, tolerancing is dimensioned with a variance of plus (+) or minus (-).

This variance can be indicated, as in the left of the example. On the right, a rod and hole are depicted. Notice that both parts are dimensioned showing a clearance fit between the two mating parts. This is another way to dimension tolerances. Tolerances in a title block are, UNLESS OTHERWISE SPECIFIED, in inches or millimeters. For this exercise, you use inches.

3. Open and print DIMENSION.pdf, and then complete the exercise by adding tolerance dimensioning to parts that appear to have a mating part.

Have your instructor evaluate your understanding.

In this exercise, you learned how to add dimensions and tolerances to your sketches.
Borders, blocks, and notes

You use borders to provide a drawing area for your views. In this exercise, you sketch borders and blocks and learn to create them according to ANSI/ASME standards.

Supplies you need for this exercise:

- Open *GRID.pdf* or obtain a sketchbook.
- Pencil
- Scale

To create a drawing border


**ANSI/ASME Y14.1—1995 DRAWING SHEET AND FORMAT STANDARDS**

- A SIZE—8 1/2 x 11

2. You plan a border through sketching. Draw the border with a 3/4" margin from the right, top, and bottom edge of the sheet.

The left side of the sheet should have a margin of 1 3/4" for binding a set of drawings together.
3. You draw border lines at a 0.8 mm width. Microfilm centering arrows, rounded corners, and zoning letters/numbers are optional on borders.

4. Open and print GRID.pdf, or use your sketchbook, and sketch a border layout. The area within your border is the drawing area.
**To create a title block**

1. A title block includes important drawing information such as:

   - Company name and address
   - Sheet size
   - Part name
   - Scale

Title blocks also follow ANSI Y14.1—1995 standards and are required on all engineering drawings.

You can chain title blocks together with other block types and general notes.

**ANSI/ASME Y14.1—1995 DRAWING SHEET AND FORMAT STANDARDS**

Refer to the numbered list and example for typical title block entries:

1. Company Name and Address
2. Drawn By (ex. initials, WER)
3. Part Name (ex. WASHER)
4. Date (ex. 16 DEC 01)
5. Sheet Size (ex. A, B, C, etc.)
6. Approved (by checker with initials)
7. Drawing or Part Number (ex. 1-A, A-A)
8. Revision letter/number of part (ex. 1, A)
9. Scale (ex. FULL SCALE)
10. Material (ex. ASE 1045)
11. Sheet Number (ex. 1 OF 20)
12. Third Angle Projection symbol (used to represent orthographic projection; top, front, and right-side view)
13. Material Finish (ex. REMOVE ALL BURRS)
14. Unspecified Tolerances (ex. tolerances of)
15. Unless Otherwise Specified, specified as inches for this exercise (ex. identified as millimeters or inches)
2. In mechanical engineering drawings, you locate title blocks at the lower-right corner. This location allows you to flip through a set of bound drawings without having to completely unfold each drawing. You can organize title blocks differently, as long as the pertinent information is contained within them.

As engineers test parts, new drawings of the same part need to be made for changes. These changes require a revision of the drawing, therefore a revision block is also necessary. Revision blocks can be connected to the title block or located in the upper-right corner of the drawing.

1. Engineering change notice (ECN) letter/number (ex. 1239)
2. Revision letter/number of part (ex. 1, A)
3. Zone letter/number (ex. 7-D)
4. DESCRIPTION of part (ex. WASHER)
5. Date when the ECN is ready for production (ex. 16 DEC 04)
6. Approved (by checker with initials)

<table>
<thead>
<tr>
<th>E CN</th>
<th>REV</th>
<th>ZONE</th>
<th>DESCRIPTION</th>
<th>DATE</th>
<th>APPROVED</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
</tbody>
</table>

3. Continue by including a title and revision block within your border sketch. Remember, the dimensions of the blocks will be determined by you as the company.

4. Open blocks.pdf as a reference for what the final sketch of a title block and revision block should look like.

To add general notes

1. According to ANSI standards, you locate general notes next to the title block. The exact location depends upon company standards. A common location for general notes is at the lower left corner of the drawing area.


   NOTES:

2. For mechanical engineering, the first note is always INTERPRET DIMENSIONS AND TOLERANCES PER ASME Y14.5M-1994, because dimensions and tolerances are adapted from it, even though it is an all-metric standard.
3. Add general notes to continue your sketch. Use ANSI/ASME standards to fill out the blocks. Remember that the text height is either 0.125" or 0.188" and all text is uppercase block letters.

In this exercise, you sketched a border, title block, and revision block, and added general notes.
Exercise 5 - Conceptual Design and Rough Sketching

Once you understand how to measure, visualize, and annotate drawings, you can begin developing a consumer product.

A product takes about three months to one year to develop, depending upon the company and nature of the product.

In this exercise, you will develop the idea for your product following the design process, and learn how to develop rough sketches. You use your new skills of scale, multiview drawing, and annotation to create a complete set of sketches.

Conceptual design is a creative process. You use a pencil and grid paper. The quality of your sketches in the conceptual phase can be loose and sketchy. Although, if someone else is reading them they need to be able to interpret them, so good line quality is important.

Supplies required for this exercise:

- Open and print GRID.pdf and ISO_GRID.pdf, or obtain a sketchbook.
- Pencil
Create a conceptual design

1. The first step in designing a product is to have a purpose and a need.

Scenario:

Carl Boss and Furniture Co. needs a low-cost drawer glide for kitchen cabinets to be installed in a new housing development. There will be five hundred new homes built in the Coventry Estates. The housing developer is also working on an additional contract thirty miles away and has subcontracted Carl Boss to install kitchen cabinets into these homes as well. Carl Boss comes to you, a mechanical engineer, seeking a less expensive design for a drawer hardware system. In order to receive the contract for the cabinet installs, he made a low bid and agreed to install the cabinets for less money than another furniture company.

Carl's current drawer slides cost $6 each wholesale. He knows that with a wood guide and plastic rail system, he could have the parts made for one-fifth the cost. He needs a sound design that will be strong enough to last thirty years.

2. In order to come up with a good design idea, you write down, or brainstorm, your ideas.

You use a web, fishbone diagrams, and a word list to do this. They all follow a similar process of writing down one key word, then a word relating to that one, and a word relating to that one. In your case, you have a drawer glide in the middle and from that, metal, plastic, and wood. You include bottom, sides, and a top. As you follow this process, you gather and formulate your thoughts on paper and move toward a design.

3. Open and print BRAINSTORM.pdf, or use your sketchbook, to begin your own web, fishpond diagram, or word link of a drawer glide referring to the scenario.

4. Once you have a design, you begin by creating thumbnail sketches of what the parts might look like.

A thumbnail sketch is a small 2" x 2" drawing of your concept or idea. Thumbnails are small, so you can quickly construct your ideas on paper. In this process, you should draw at least
five concept drawings of each part, wait a day to think about them, then select one to begin a rough sketch and work out any possible problems with the design.

5. Open and print GRID.pdf, or use your sketchbook, to begin your thumbnail sketches of the drawer slide.

6. During this process of waiting and thinking about your concept ideas, you research your idea. You look at hardware companies on the Web to research your ideas and gain a direction.

Open www.msn.com or another search engine to begin your research of drawer glides.

Autodesk is not responsible for the content of external internet sites nor links on those internet sites to other internet sites.

7. Once you begin your research, your concept ideas undergo further development by applying research to the design.
Research is important, because you need to know what has been done previously in order to design something different. You apply the research results to your product on a continual basis. Research is an ongoing process in creating your sketches. You can never do enough research, but you need to be productive in researching so you do not waste time.

Through your research, you discover your slide needs to be made out of nylon for a smooth ride. You also confirm that having a dovetail pattern would reduce the amount of parts needed for the drawer glide system. You will need a rail, slide, and screws. You determine that you could have the rails manufactured out of wood for 10¢ a piece and the glide by X-O Plastics Corporation for 50¢ each. Screws are 1¢ each and you can purchase them in mass quantity. The total for production and labor is less than $1 per drawer glide system.

8. Constraints in the part need to be considered, such as weak areas in your design. Also, at this stage you need to consider an approach for development and proposal.

9. You now need to develop measurements of the parts based upon the design needs of Carl Boss. You consult with Carl and reach a decision that the glide needs to be 4.25" long, 2.5" wide, and 2" high.
Additional measurements are the base at 0.75", upper thickness at 0.625", the dovetail at 0.375" deep and 1" wide at 56°, and the holes for the screws at 0.25". The holes need to countersunk. You need to drill the first two holes in the base at 0.75" from the opposite end of the dovetail. Then you space the other 1.5" in from the center of the first hole. You drill the last hole in the upper thickness, 0.625" down.

Next you develop a set of drawings and a proposal presentation for the customer. A consumer product must meet the needs and demands of the customer. You are not designing the part for yourself.

Now that some preliminary research and rough sketches are done, you need to resketch the parts as 2D and 3D, with annotations.

In the next exercises, you create an isometric (3D) and orthographic (2D) sketch for the design proposal, the next step in the design process. Sketching is the beginning of the design process and additional steps will be given in lessons 2 and 3 of this unit.

In this exercise, you learned how to create a conceptual sketch and how to use the beginnings of the design process.
Exercise 6 - Orthographic Sketching

Orthographic sketching is similar to multiview sketching. Instead of six views, orthographic projection typically relies on three:

- Top
- Front
- Right or left side

Orthographic sketching communicates three distinct sides of the part so the manufacturer can visualize it. In order to manufacture the part, you must also include annotations.

In this exercise, you create an orthographic sketch with annotations of your concept part.

Supplies required for this exercise:

- Open and print GRID.pdf, or obtain a sketchbook.
- Pencil
- Scale
Layout preparation

1. Sketch your A size sheet with a border, title block, and revision block. At this time, do not fill in the block information. Open BLOCKS.pdf, for an example, or review the previous exercise.

2. In the design process, you determined the length, width, height (4.25", 2.5", 2"), and additional dimensions:

- Length 4.25"
- Width 2.5"
- Height 2"
- Base 0.75"
- Upper thickness 0.625"
- Dovetail 0.375" deep, 1", and 56°
- Holes 0.25" countersink
- 1st hole 0.75" in from the opposite end of the dovetail
- 2nd hole spaced 1.5" in from the center of the first hole
- 3rd hole in upper thickness 0.625" from top

3. Use the length, width, and height to create the plan for your orthographic drawing in the drawing area. Decide how many inches to place between the views. For this example, use 2.0". Use the already determined dimensions and the distance between the views with your engineering scale for layout.

4. Find the sum of the dimensions vertically, and then horizontally. This will give you the dimensions of the overall rectangle that contains all three orthographic views.

With 6.5" as the width and 8.75" as the length, the orthographic drawing will not fit on A size paper. You will need to sketch in half scale, so divide the length and width by 2, using your scale. Add object lines of the three views. This is your orthographic plan for your sheet drawing area.
5. Use your orthographic plan to lay out the drawing area on your sheet by using construction lines. Position views on the paper need to be clearly visible and readable. If using B size and above, you can position the orthographic layout in the middle of the drawing area by creating diagonal lines for positioning. Notice that for A size, center positioning does not always work.

6. Position your orthographic layout to be clear and legible. Remember to leave room for dimensions and annotation.

In this exercise, you learned how to lay out an orthographic drawing.
Orthographic projection

In this next exercise, you learn how to create orthographic views of a part or product.

Note: Refer to Change the Active Project before you start this exercise.

1. In Autodesk Inventor, open Dovetail_slide.ipt. Now that you conceptually developed the dovetail slide in the previous exercise, you can create orthographic sketches using the Autodesk Inventor model for reference.

2. An orthographic sketch is the top, front, and right side. It is similar to multiview sketching.
3. Click the Look At tool, and then click on the front face as shown in the following image:
4. The object rotates into the orthographic front view.

5. Right-click on the view, and then select Isometric View. The object will rotate back into the isometric view. Repeat this workflow for the top and right-side views.

6. Now that you have an understanding of how the front, top, and right-side views look, you begin drawing the views. Use your prepared sheet and draw two new lines with your scale to define the front view. You draw one vertical line 0.625" to the right and one horizontal line 0.75" from the bottom.
7. Add another vertical line from the left at 0.125" and a horizontal line from the bottom at 0.125".

Darken in the view as shown below. Construction lines should be hardly visible and object lines are 0.6 mm wide. The front view is now defined.

8. Add construction lines for the top view, and then darken the object lines. Project construction lines from the top view until they stop at the 45° angle in the upper-right side of the sketch. Projecting construction lines from one view to another is orthographic projection.
9. Sketch the right-side view. The front and top view construction lines helped you draw the right-side view.

10. By making the construction lines hardly visible, the three orthographic views appear to stand out on the page.
11. The construction lines are hardly visible, so you can use them to place the hidden lines. Hidden lines are 0.4 mm wide.

12. Add centerlines to all symmetrical parts and holes. Centerlines are 0.3 mm wide.

Note: The construction lines have been omitted from this sketch.

In this exercise, you learned orthographic projection.
Dimensioning and annotating a sketch

In this next exercise, you learn how to add dimensioning and annotations to your sketches.

1. Dimensioning must be clear and legible for the viewer. Place most of the dimensions inside of the orthographic layout. Although it is good practice to place dimensioning within the orthographic layout, it may not all fit. The rule in this case is to place the dimensions in a location that is clear and legible.
2. Add all horizontal and vertical dimensions, trying to keep it in the orthographic layout. In this example, there is not enough room for the horizontal and vertical dimensioning to fit inside the orthographic layout. Instead, make sure that it is clear and legible.

3. Add any leaders denoting the size of any holes or notes that need to be added. In this example, a notation of COUNTERSINK and ROUND is added. The notations are annotations with the help of leaders. You can also add them in the additional notes or general notes.
4. Add additional dimensions or notes where required. For example, add a dimension for the angle of the dovetail.

5. With the dimensioning complete, fill out the blocks and add any notes. There is no approval or revision number. In your situation, your instructor will approve it and a revision number will be assigned to the next drawing if you need to revise it. This is why the revision block is not filled out. The general note block includes tolerancing, the third angle projection symbol (indicating that this sketch is an orthographic projection), and material finish. The additional note indicates the dimensioning and tolerance standard.
6. Your orthographic drawing is almost complete, but it needs to have a three-dimensional view of the part for additional visualization for the manufacturer. The next drawing is isometric.

![Isometric Drawing](image)

7. Open DOVETAIL_SLIDE.pdf, for an example of the complete working drawing. Have your instructor evaluate your sketches, your understanding of orthographic drawing, dimensions, annotations, and borders(blocks).

In this exercise, you learned to dimension and annotate a sketch.
Exercise 7 - Isometric Sketching

In this exercise, you learn to create isometric drawings and place them on a sheet.

Supplies required for this exercise:

- Open and print ISO_GRID.pdf, or obtain a sketchbook.
- Pencil
- Scale
Isometric drawing

1. Open *Dovetail_slide.ipt*. An isometric drawing shows the top, front, and right side.

![Isometric Drawing](image)

2. An isometric drawing horizontal X axis shifts from 0° to 30° in one direction and 150° in the other. The result is a 3D representation of a solid.

![Orthographic vs Isometric](image)

3. To begin an isometric drawing you draw three lines:
   - Length
   - Width
   - Height

Use your engineering scale to measure half scale.
4. From these three lines, you complete the box that the isometric drawing will be cut from.
5. Cut the isometric view out of the box by defining the base and upper thickness.

6. Cut the dovetail, holes, and round edges.
7. Complete the isometric drawing by adding centerlines for all symmetrical parts.

8. Complete the orthographic drawing by adding the isometric sketch into the upper-right corner of the orthographic layout.

If the isometric view does not fit in the corner, you position it on the sheet in the drawing area so it is clearly visible. The isometric drawing moves to allow for the revision block to be added.

9. Open DOVETAIL_SLIDE.pdf for an example of a complete working drawing. Have your instructor evaluate your sketches, your understanding of orthographic drawing, isometric drawing, dimensions, annotations, and borders/blocks.

In this exercise, you learned to create an isometric sketch and successfully completed a working drawing. A working drawing is complete because a part or product can be manufactured from it. The drawing contains all the required information to produce the part, such as multiviews, dimensions, and annotations.
Summary/Questions of Sketching and Annotation

Summary

In this lesson, you learned to:

- Read a ruler and scale.
- Visualize 3D objects as 2D sketches.
- Use linetypes in sketches.
- Dimension and annotate sketches.
- Develop a conceptual design.
- Sketch an orthographic drawing.
- Sketch an isometric drawing.
- Create a working drawing.

Questions

1. If a solid part needs to be represented as quarter scale on a sheet, what tool would you utilize first?
   
   a. A ruler
   
   b. An architecture scale
   
   c. An engineering scale

2. How many orthographic views does a sphere require?
   
   a. One
   
   b. Six
   
   c. Two
   
   d. Three

3. Linetypes are all the same width.
   
   a. True
   
   b. False

   
   a. True
4. Which linetype do you rely on most in orthographic projection?
   a. Border lines
   b. Centerlines
   c. Dimension Lines
   d. Construction lines

5. Conceptual design is a creative process.
   a. True
   b. False

6. Which linetype do you rely on most in orthographic projection?
   a. Border lines
   b. Centerlines
   c. Dimension Lines
   d. Construction lines

7. Isometric drawing is a 3D representation.
   a. True
   b. False

8. A working drawing is a drawing that a person can create a part from?
   a. True
   b. False
Lesson 2 - 2D Representation

When you finish sketching and planning your drawing, you need a set of production drawings for your client. Production drawings are working drawings that include every drawing that is necessary to manufacture the part.

The key to developing a good set of production drawings is to start with a plan or sketch. You have already completed your plans for the dovetail slide in the previous lesson. You use your final sketch of the dovetail slide to complete this lesson.

Preparation

To create a CAD drawing, you must install AutoCAD® or Autodesk® Architectural Desktop.

© 2008 Autodesk, Inc.
Exercises

- Layout and Preparation
- Orthographic Projection
- Dimensioning and Annotating

Standards

This lesson meets standards for Science Content, Math, Language Arts, and Technology.

Key Terms

<table>
<thead>
<tr>
<th>Chamfer</th>
<th>Grid</th>
<th>Orbit</th>
<th>Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension Style</td>
<td>Layers</td>
<td>Pan</td>
<td>Units</td>
</tr>
<tr>
<td>Drawing Limits</td>
<td>Layout space</td>
<td>Size</td>
<td>Zoom</td>
</tr>
<tr>
<td>Fillet</td>
<td>Model space</td>
<td>Snap</td>
<td></td>
</tr>
</tbody>
</table>

Evaluation

You evaluate students on the completion of the exercises.

Resources

Exercises

Procedure

1. Start by Completing Lesson 1 - Sketching tools and techniques. (Student)
2. Review the working drawing created in Lesson 1. (Student)
3. Complete Exercise - Layout and Preparation (Student)
4. Complete Exercise - Orthographic Drawing (Student)
5. Complete Exercise - Dimensioning and Annotating (Student)
Exercise 1 - Layout and Preparation

In this exercise, you start a new drawing in AutoCAD, and then set up drawing limits, layers, grid, and snap.

**Set drawing limits**

1. Start AutoCAD.
   - If New Features Workshop is displayed, select Maybe Later, and then click OK.
   - On the Command line, enter `startup`.
   - Enter 1, and then press Enter.

   *Note*: These steps enable the Create New Drawing dialog box when you select QNew.

2. Click QNew.
   - Click Start from Scratch.
• Select Imperial (feet and inches).

• Click OK.

3. On the Format menu, click Drawing Limits.

On the Command Line, the prompt asks for the lower left corner of your drawing area. This is normally 0,0. Data contained in the < and > symbols are the defaults. In this example, you do not have to enter any coordinates.

4. Press ENTER.

On the command line you are prompted to enter the coordinates of the upper-right corner of your drawing area.

5. Enter 10.5,8. These settings will print your drawing on A-Size paper at full size.

6. On the status bar, click Grid Display to view the drawing limits.
**Set snap and grid**

1. On the status bar, right-click on Snap or Grid, and then click Settings. The Drafting Settings dialog box is displayed.

2. Confirm there is a check mark in Snap On and Grid On, and then set snap to 0.5" and grid to 1.0" for both X and Y coordinates.

3. Click OK.

4. The grid displays a dot at every one inch and snap at every one half inch. As you move your cursor it snaps on the dots and in-between the dots.

5. On the status bar, right-click on the Snap or Grid, and then click Settings.

6. Change snap to 0.25" and grid to 0.5". When you change the X spacing and click on the Y spacing, it copies the X spacing value to the Y spacing.
Create layers


2. Click New Layer.

- Enter CENTER.
- Click the color swatch, and then enter green.
- Under Linetype, click the Continuous entry for the CENTER layer, and then click Load.
- In Available Linetypes, click CENTER, and then click OK.
- In the Select Linetype dialog box, select CENTER, and then click OK.
- Click the Lineweight entry, select 0.30 mm, and then click OK.
- Click Apply to save the new layer properties.
- Repeat the process for the following layers.

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>Linetype</th>
<th>Lineweight</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>White</td>
<td>Continuous</td>
<td>Default</td>
</tr>
<tr>
<td>DIMENSION</td>
<td>Green</td>
<td>Continuous</td>
<td>0.30mm</td>
</tr>
<tr>
<td>HIDDEN</td>
<td>Red</td>
<td>HIDDEN2</td>
<td>0.40mm</td>
</tr>
<tr>
<td>ANNOTATIONS</td>
<td>Green</td>
<td>Continuous</td>
<td>0.30mm</td>
</tr>
<tr>
<td>OBJECT</td>
<td>Red</td>
<td>Continuous</td>
<td>0.60mm</td>
</tr>
</tbody>
</table>
3. On the Layers toolbar, click the Layer control, and then click the layer name you want to use.

4. Save your drawing as Dovetail_slide.dwg.

**Working with AutoCAD**

1. On the Draw toolbar, click Line. Place lines on each layer and note the different colors, linetypes, and lineweights.

   **Note:** The LWT button on the status bar must be selected to display lineweights.

2. On the Standard toolbar, use the Zoom and Pan tools to navigate around the working area.
On the Standard toolbar, click Redo or Undo as you place lines.

3. On the Modify toolbar, click Erase, select all the objects you have drawn, and then right-click to erase the lines.

4. Do not save the file.

In this exercise, you learned how to set up drawing limits, snap, grid, and layers.
Exercise 2 - Orthographic Projection

In this exercise, you create an orthographic projection of a part or product in AutoCAD for a production drawing. You use AutoCAD to create and draw an orthographic drawing using your sketch as a plan or guide.

Use the line and trim commands

1. Open Snap_grid_line.dwg and practice drawing lines with snap and grid settings. You will also use the trim command to complete sections of the exercise.

To complete the exercises, refer to the completed drawing. For example, 1.A is the completed drawing and you have to make 1.B look exactly the same.

2. To complete 1. B,
   - Review the line colors in 1. A.
• Set the current layer to one of the colors. For example, the vertical lines are on the MAGENTA layer.

• On the Status bar, only Snap, Grid, and Model should be selected.

• Draw the seven vertical lines.

• Repeat this workflow for the horizontal lines.

3. Close the file when you are finished the six exercises. Do not save the file.

**Orthographic projection**

Now that you understand how to create and trim lines in AutoCAD, start the orthographic drawing process by drawing a box that contains all three views.

1. Open *Dovetail_slide.dwg*. This the drawing you created in the previous exercise.

2. Set your drawing area limits at **10.5,8**, and then set your X,Y snap to **0.25"** and grid to **1.0"**.
3. Use the following sketch (from Lesson 1) as a guide for your drawing.

4. Make 0 the current layer. You will place construction lines on this layer.

5. Click Line.

6. Create the construction lines as shown.

7. Save the file.
Use edit and modify commands

In this section of the exercise, you use the Erase, Copy, Move, Stretch, Extend, and Trim commands. A typical design session uses these edit and modify commands.

1. Open Edit.dwg and practice editing and modifying. Review the completed exercise, and then use an appropriate workflow to make the adjacent drawing exactly the same.

2. Repeat this process for Extend.dwg, Stretch.dwg, and Trim.dwg to practice modifying objects.

3. Close all the drawings when you have practiced the edit and modify commands. Do not save the files.

Finish the drawing

1. Review the sketch for the completed drawing.

2. Use the following commands to complete the drawing. Remember to set the correct layer for each linetype.

   - On the Draw toolbar, click Circle to create circles.
   - On the Modify toolbar, click Fillet to create round edges.
   - On the Modify toolbar, click Chamfer to create angled edges.
3. Make HIDDEN the current layer.

4. On the Draw toolbar, click Line to begin to draw Hidden Lines.
5. Add centerlines using the same workflow.

6. On the Layers toolbar, click Layer control, and then click the lightbulb symbol beside layer 0 to turn off the visibility of the construction lines.

7. Save your drawing as `dovetail_slide.dwg`.

In this exercise, you created a production drawing using orthographic projection.
Exercise 3 - Dimensioning and Annotating

In this exercise, you learn to create a layout from a template, and add dimensions and annotations to your production drawing.

Create a layout

1. Open Dovetail_slide.dwg. This the drawing you created in the previous exercise.

2. Right-click Layout1, and then click From template.
3. In the Select Template From File dialog box, select ANSI A - Named Plot Styles, and then click Open.

4. On the Insert Layout(s) dialog box, click OK. A new ANSI A Title Block is created.

5. Right-click Layout1, and then select Delete.

6. Click OK to delete the layout.

7. Delete the Layout2 tab.

8. On the Modify toolbar, click Scale.
   - Select the objects by clicking on the upper-left corner away from the drawing, and then dragging across to the lower-right corner and clicking again.
   - Right-click to accept, and then click anywhere for a base point to begin scaling.
   - On the command line, enter 0.5, and then press ENTER.
9. On the bottom of the drawing area, click on the ANSI A Title Block tab.

10. Double-click on the drawing area. The line around the viewport is displayed as a thicker line. You are now viewing your drawing in model space.

11. On the Standard Toolbar, click Pan Realtime, and then position the orthographic drawing. Refer to your sketch for positioning.
Add dimensions and annotation

Dimensions must be clear and legible for the viewer. You place most dimensions inside of the orthographic layout. Although it is good practice to place dimensions within the orthographic layout, it may not all fit. The rule in this case is to place the dimensions in a location that is clear and legible.

1. Right-click on any icon, and then select Dimension.

Note: Production drawings should be printed in black or monochrome. To illustrate an example of a production drawing, all colors for the exercise will be black or set to white in AutoCAD to print black. Some images in this exercise will remain in color for viewer visualization purposes.

2. On the Dimensioning toolbar, click Linear Dimension for vertical and horizontal dimensioning.
   - Select the first extension line origin, or an object line intersection.
• Select the second origin, or the furthest point away from the first to indicate the length of the dimension.

• Click to specify the dimension location 0.375" away from the object line according to ANSI standards.

3. On the Dimensioning toolbar, click Quick Leader for the fillet and chamfer notation.

Add leaders to denote the dimensioning of any holes or notes that need to be added. You add a notation of COUNTERSINK and ROUND. Notations are annotations with the help of leaders. They can also be added to the additional notes or general notes.

4. On the Dimensioning toolbar, click Diameter Dimension for the holes.

5. On the Dimensioning toolbar, click Angular Dimension. Add the dimension for the dovetail.

6. On the Dimension toolbar, click Dimension Style.
7. In Dimension Style Manager, click Modify, and then click the Lines tab.

- Change the Extend beyond dim lines: to 0.125.
- Click the Symbols and Arrows tab and change Arrow size to 0.125.
- Click the Text tab and change the Text height: to 0.125.
- Click on the Primary Units tab and change the Precision to 0.000 for linear and angular dimensioning.
- In Measurement scale, change the Scale factor to 2.0 or double scale (this will ensure that the half scale drawing will display full size measurements).
- Click OK, and then click Set Current.

Now the dimensions are added to the drawing, fill out the blocks and add any notes. There is no approval or revision number.

For this drawing, your instructor will approve it, and assign a revision number to the next drawing if you need to revise it. This is why the revision block is not completed. The general note block includes tolerancing, the third angle projection symbol (indicating that this sketch is an orthographic projection) and material finish. The additional note indicates the dimensioning and tolerance standard.

8. On the Draw menu, click Text. Select the single line text to fill out the block. On the command line, follow the prompts. You also use the multiline text according to company standards.
9. Save your drawing as *dovetail_slide.dwg*.

Your orthographic drawing is almost completed. It requires a three-dimensional view of the part for visualization of the production drawing. This type of drawing is called isometric.

In this exercise, you learned to create a layout, dimension, and annotate a drawing.
Summary/Questions of 2D Representation

Summary

In this lesson, you learned to:

- Set up a drawing in AutoCAD.
- Set drawing limits.
- Use snap and grid.
- Set up and use layers.
- Create an orthographic drawing in AutoCAD.
- Dimension and annotate in AutoCAD.

Questions

1. To set up your working area in AutoCAD, which tool would you use first?
   
   a. Grid
   
   b. Drawing Limits
   
   c. Snap

2. How often do you change the grid and snap?
   
   a. The first time you begin a drawing
   
   b. Once
   
   c. As often as needed during a design session

3. Use layers to keep drawings organized.
   
   a. True
   
   b. False

4. How many layers do you need for a drawing?
   
   a. Five
   
   b. One
   
   c. As many as needed during a design session

5. The orthographic drawing process is the same as hand drawing or sketching.
6. Is your sketch the same as a production drawing?
   a. Yes
   b. No

7. You should plan out every production drawing with sketching before you begin to use AutoCAD.
   a. True
   b. False

8. There is no need to annotate a sketch to help you create a production drawing.
   a. True
   b. False
Lesson 3 - 3D Representation

Your orthographic drawing contains a sheet layout, annotations, and dimensioning. A 3D representation is required to complete the drawing.

For this project, you use isometric drawing, which is a type of axonometric projection.

In this lesson, you complete a production drawing by adding an isometric view for 3D representation or visualization of the part.

**Preparation**

In order to complete this lesson, you need to install AutoCAD or AutoCAD Architectural Desktop.
Exercises

- Isometric Drawing

Standards

This lesson meets standards for Science Content, Math, Language Arts, and Technology.

Evaluation

You evaluate students on the completion of the exercises and a production drawing.

Resources

Exercises

Procedure

1. Start by Completing Lesson 1 - Sketching tools and techniques. (Student)
2. Review the working drawing you created in Lesson 1. (Student)
3. Complete Lesson 2 - 2D Representation. (Student)
4. Complete Exercise - Isometric Drawing. (Student)
Exercise 1 - Isometric Drawing

In this exercise, you use AutoCAD to create an isometric drawing for a production drawing.

Create an isometric drawing

1. Start AutoCAD.

2. On the status bar, right-click Snap or Grid, and then select Settings.
   - Make sure there is a check mark in Snap On and Grid On.
   - In Snap type, select Isometric snap.
   - Set Snap Y spacing and Grid Y spacing to **0.250"**.
**Note**: An isometric drawing horizontal X-axis shifts from 0° to 30° in one direction and 150° in the other.

The result is a 3D representation of a solid. All lines are true length or actual length even though they shift 30°.

3. Start your isometric drawing on the Object layer. Create lines for length (4.25), width (2), and height (2.5). You will trim and copy the lines, so you do not need a construction layer. Draw the part at full scale, and then change it to half scale later in the exercise.
Tip: Move between the different planes using F5 or Ctrl-E to toggle back and forth between the top, front, and right-side planes.

Use these three lines to complete an isometric box.

4. On the status bar, turn on OSNAP.

5. On the Modify toolbar, click Copy, and then create copies of the length, height, and width lines.

6. Cut the box by defining the base and upper thickness.
Use the ellipse command

1. Open *Ellipse.dwg* to practice using the Ellipse command for the isometric drawing. Close the file when you are finished.
Complete the isometric drawing

1. Continue by cutting the dovetail, holes, and round edges.

**Tip:** For this drawing, use the Draw > Ellipse > Axis, End > Isocircle ellipse option.

2. Trim the part out from the outer box.
3. Create a Center Layer, and then add centerlines to all symmetrical parts to complete the isometric drawing.

4. On the Modify toolbar, click Scale. Select the entire isometric drawing and scale it to 0.5.

5. Save your drawing as Iso_dovetail_slide.dwg.
### Complete the layout

Add the isometric sketch into the upper-right corner of the orthographic layout to complete the orthographic drawing.

1. ![Open Dovetail_slide.dwg.](image)

2. Click the ANSI A Title Block tab at the bottom of the drawing area.

3. ![On the Draw toolbar, click Insert Block.](image)
   - Browse to Iso_dovetail_slide.dwg.
   - Click Open.
   - Click OK.
   - Specify the insertion point to locate the isometric drawing.
4. Save the drawing.

In this exercise, you learned how to create an isometric drawing. You successfully completed a production drawing.
Summary/Questions of 3D Representation

Summary

In this lesson, you learned to:

• Create an isometric ellipse.
• Create an isometric drawing in AutoCAD.

Questions

1. Why is a 3D representation included in a production drawing?
   a. Because it looks neat and organized.
   b. Because it looks better.
   c. For the viewer to better visualize the part.

2. What type of ellipse do you use in an isometric drawing?
   a. Arc
   b. Center
   c. Isocircle

3. What shortcut key do you use to change planes in isometric snap?
   a. R
   b. F5
   c. Ctrl-E
   d. Both b and c

4. How do you begin an isometric drawing?
   a. Any way that you want.
   b. With three lines, then to a box.
   c. A box with the overall length, width, and height, of the part.
Lesson 4 - Word Processing

Using Microsoft® Office Word you can conceptualize, write, edit, and then print your work.

We encourage you to experiment, make mistakes, and have some fun with these basic word processing lessons.

Preparation

In order to complete this lesson, you need to install Microsoft Office Word. The images in the exercises are based on Office 2003.

Exercises

- Create a New Document
- Use the Menu Bar
- Learn to Use Fonts
- Spelling and Grammar Check
- Edit Your Document
- Place Your Document into HTML

Standards

This lesson meets standards for Science Content, Math, Language Arts, and Technology.

Evaluation

You will evaluate students on the completion of the exercises.

Resources

Exercises
Microsoft Online Help

Procedure

1. Review the Microsoft Office Word user-interface. (Teacher)
2. Complete Exercise - Create a New Document. (Student)
3. Complete Exercise - Use the Menu Bar. (Student)
4. Complete Exercise - Learn to Use Fonts. (Student)

5. Complete Exercise - Spelling and Grammar Check. (Student).

6. Complete Exercise - Edit Your Document. (Student)

7. Complete Exercise - Place Your Document into HTML. (Student)
Exercise 1 - Create a New Document

Create a new document, then save your document to a directory on your hard drive. Reopen the document, print it, and save it again.

**Note:** Make sure your printer is properly configured before you start this lesson.

**To create a document**

1. On the desktop, double-click the Microsoft Word desktop icon, or at the bottom of the screen on the taskbar, click the Start > All Programs. From the list, click Microsoft Office Word 2003. A new document is displayed.

2. On your blank page, enter: **Using Microsoft Office Word you can conceptualize, write, edit, and then print your document.**

Next, you save your document.

3. On the File menu, click Save As to display the Save As dialog box. Microsoft Word defaults to the My Documents directory.

   - In the Save As dialog box in File Name, enter **CreateNewDoc**
   - Click Save.
Word defaults to the .doc file extension after you type the title of your document. You have saved the document.

**Tip**: As you work on your document, save it at regular intervals by pressing CTRL S.

- At the top right corner of Word, click Close Window. This exits the current document, but leaves Word running.

**Print your document.**

1. On the File menu, select CreateNewDoc.doc from the recent files list.

2. On the Standard toolbar, click Print (or press CTRL P) to display the Print dialog box.

3. Select OK. Your document will print to the default printer.

4. Save your document using your class filenaming conventions.

5. On the File menu, select Exit. You may have to extend the menu selection to access Exit.

In this exercise, you created and saved a new document; and then reopened the document for revisions, printed it, saved it again, and then exited the document.
Exercise 2 - Use the Menu Bar

In this exercise, you explore the Main Menu bar.

![Image of Microsoft Word menu bar]

To explore the Main Menu bar

1. On the desktop, double-click the Microsoft Word desktop icon, or on the taskbar click the Start icon, and then select All Programs. From the list, click Microsoft Office Word. A new document named Document1 is created.

2. On the Main Menu bar, click File. A pull-down menu appears with a subset of all the options. Microsoft Office automatically customizes menus and toolbars based on how often you use the commands.

- Click the arrows at the bottom of the menu to show all the commands.
- The most commonly used commands are:
  - Open
  - Save
  - Save As
  - Page Setup
  - Print
3. On the Main Menu bar, continue to click each option (and the down arrows in the pull-down menus) until you arrive at the Help option.

4. On the Main Menu bar, click Help.
   - On the pull-down menu, select Show the Office Assistant.
- Click the Office Assistant. It gives you the option to type in any question you may have concerning Word.

![Office Assistant](image1)

- Enter **save a document**, and then click Search.

![Office Assistant](image2)

- The Office Assistant provides a list of the various ways you can save your documents.
- Review the list, right-click the Office Assistant, and then click Choose Assistant.
• Don't like Clippit? Click Next to review the other assistant options.

• Click OK.

• Right-click the Office Assistant, and then click Hide.

**Note**: The Office Assistant is a handy device to give you direction and troubleshoot any word processing questions you may have.

5. Exit your Word document and do not save the file.

In this exercise, you explored the Main Menu bar.
Exercise 3 - Learn to Use Fonts

Fonts are the actual letter styles and sizes that you enter in your documents using your keyboard.

In this exercise, you learn to use the various fonts Microsoft Word provides to customize documents.

Customize a font

1. On the desktop, double-click the Microsoft Word desktop icon, or on the taskbar click the Start icon, and then select All Programs. From the list, click Microsoft Office Word. A new document named Document1 is created.

2. Enter: **Use the Microsoft Office Word font options to customize your documents.**

3. On the Formatting toolbar, note these options:
   - Normal (the current style)
   - Times Roman (the Microsoft Word font default)
   - The number 12 font (the Microsoft Word letter size default)

4. To the right of Normal, click the down arrow. These options appear:
   - Clear formatting
   - Heading 1
   - Heading 2
   - Heading 3
   - Normal
   - 1. Style Numbered1
   - More
5. In your document, place the cursor before the word Use.
   - Click and drag the cursor to the end of the text. The text is highlighted.
   - On the Style list, click Heading 1. This will change the font appearance.

Note that Times Roman changes to Arial and the number 10 changes to 16.
   - Try the other style options.

6. Press ENTER to move to the next line. On the Formatting toolbar, the style should return to Normal.
   - To the right of Times Roman, click the arrow. A pull-down list is displayed.
   - Scroll through the list, and then click Courier New.
• Enter *Use the Microsoft Office Word font options to customize your documents*.

• Note the difference in typeface.

• Try the other options and type whatever you want.

**7.** Press ENTER to move to the next line. On the Formatting toolbar, the style should return to Normal.

• To the right of 12, click the arrow.

• A pull-down list appears.

• Scroll through the list, and then click 16.

• Enter *Use the Microsoft Office Word font options to customize your documents*.

• Note the difference in type size.

**8.** Scroll through each of the three pull-down menus and experiment with fonts, typeface, and size.

**9.** Do not save the file. Exit your Word document.

In this exercise, you learned the basic use of the various fonts Microsoft Word provides to customize documents.
Exercise 4 - Spelling and Grammar Check

In this exercise, you use the Spelling and Grammar feature to search for and correct any spelling or grammatical errors in your document.

Spelling and Grammar Check provides suggestions to improve what you want to say in your document.

To spell check and grammar check a document

1. On the desktop, double-click the Microsoft Word desktop icon, or on the taskbar click the Start icon, and then select All Programs. From the list, click Microsoft Office Word. A new document named Document1 is created.

2. On the File menu, select Open.
   - From the My Documents directory, select CreateNewDoc.doc, and then click Open.
   - The previously created document is displayed.

3. On your page, enter: Using Microsoft Office Word you can conceptualize, write, edit, and then print your document. Place your cursor after "Word" and enter e.

Note that for this exercise you are purposely misspelling "Worde" and that in your document "Worde" is underlined. Word automatically points out any incorrect spellings or grammatical errors.

4. On the Main menu > click Tools, and then click Spelling and Grammar.
   - The Spelling and Grammar dialog box is displayed.
   - The entire sentence appears and "Worde" is highlighted.
   - Below, a list appears with recommended changes. You may accept or ignore the suggestions by clicking on either Change or Ignore icons.
From the list, select "Word", and then click Change.

The word is corrected and the Spelling and Grammar check continues throughout the entire document.

Microsoft Word scans your document, and in the Spelling and Grammar dialog box points out any errors and offers corrections and suggestions. You may accept or ignore these suggestions by selecting either Change or Ignore.

- Click OK.

Next, check for any grammatical errors.

5. At the end of your sentence, press ENTER twice.

- Enter The computer program which reaches the customer first is often the most successful.

6. On the Tools menu, click Options.

- Click the Spelling and Grammar tab.
- In Grammar, ensure that Show readability statistics is selected.
- In Writing style, ensure that Grammar & Style is selected.
• Click OK. Word underlines an error in your document.

7. Right-click on the phrase.

• Two options are displayed, "program, which reaches the customer," OR "program that reaches the customer."

• Select "program that reaches the customer."

Your sentence changes accordingly.
8. On the Tools menu, select Spelling and Grammar (or press F7). The document is checked again, but this time the Readability Statistics are displayed.

This additional information helps you decide if your writing style is appropriate for the intended audience.

9. Click OK.

10. Click Save, and then exit your document.

In this exercise, you used the Microsoft Spelling and Grammar Check feature to search for and correct any spelling or grammatical errors in your document.
Exercise 5 - Edit Your Document

In this exercise, you will open a document, change existing text, add additional text, and then save your document.

Then, you will use the following Microsoft Word menu features to edit and change the appearance of your text:

- Copy
- Cut
- Paste
- Bold
- Underline
- Italicize
- Right, left, and center justification
- Numbered and bulleted lists

To edit a document

1. On the desktop, double-click the Microsoft Word desktop icon, or on the taskbar click the Start icon, and then select All Programs. From the list, click Microsoft Office Word. A new document named Document1 is created.

2. On the File menu, select Open. Microsoft Word defaults to your My Documents directory.

3. From the My Documents directory, select CreateNewDoc.doc.

   - The document you previously created opens and the text, "Using Microsoft Word you can conceptualize, write, edit, and then print your document." is displayed.

   - Press ENTER twice to start a new paragraph, and then enter: **You can also change the appearance of the text and move text from one area of your document to another using various features.**

   - Your document now has two paragraphs.

   - Press CTRL S to save your document. Your document is saved and remains on screen.

4. Next, use the Copy feature to revise your document by making these changes:

   - In the first paragraph highlight "Microsoft Word".

   - On the Edit menu > click Copy (or press CTRL C).
• Move your cursor into the second paragraph and place it between the words "various" and "features".

• On the Edit menu, select Paste (or press CTRL V).

Your paragraph now reads, "You can also change the appearance of the text and move text from one area of your document to another using various Microsoft Word features."

5. Use the Cut feature to revise your document by making these changes:

• In your second paragraph, highlight "using various Microsoft Word features".

• From the Edit menu, select Cut (or press CTRL X). The words you highlighted disappear.
• Place your cursor at the beginning of the second paragraph, and then from the Edit menu, select Paste (or press CTRL V).

• The text appears at the beginning of the second paragraph.

• The paragraph needs some changes. First, capitalize the word, "using".

• After the word "features", put a comma and replace the upper case Y in "You" with a lower case y.

• Highlight the word "also" and press the delete key. The word disappears.

• Your sentence now reads, "Using various Microsoft Word features, you can change the appearance of the text and move text from one area of your document to another."

• Save your document.
6. To give your document a title:

- Place your cursor at the beginning of the first paragraph and press ENTER twice.
- At the top of the page enter **Basic Word Processing**. Microsoft Word defaults to left alignment.
- Highlight what you just typed.
- On the Menu bar select the bold symbol (B).
- Then, to the right of the bold symbol, select center alignment.
- Your title is centered on the page and the text is bold.

7. To make the title stand out even more:

- Highlight the title again.
- On the Menu bar select the I (for Italic) icon and the U (for Underline) icon.
- Your title is now bold, italicized, and underlined.
- In your two paragraphs, highlight various words and experiment with these features.
- Save your document.

8. To use the bulleted lists feature to make sections of your paragraph stand out more:

- In your first paragraph enter a colon after the word "can", and then place your cursor next to the word "conceptualize" and press ENTER.
- On the Formatting toolbar, select Bullets and "conceptualize" appears with a bullet to its left.
- Place your cursor next the word "write" and press ENTER.
- Repeat this process with "edit" and "print".
- The bullets repeat themselves and you have a bulleted list of words you want to stand out.
- Remove the commas after conceptualize, write, and edit.
- Delete "and then" after the word "edit".
9. Another way to make sections of your paragraph stand out is to use the numbered lists feature.

- The process is repeated as above, except from the Formatting toolbar select the Numbering icon instead.

- Or, in this case, highlight your bulleted list and from the Formatting toolbar select the Numbering list.

- Your list is now numbered instead of bulleted.

10. Save your document.

11. Print your document.


In this exercise, you opened a document, changed existing text, added additional text, and then saved your document. You used various Microsoft Word Menu features to edit and change the appearance of your text.
Exercise 6 - Place Your Document into HTML

To complete this exercise you must have an HTML editor such as Macromedia HomeSite™ or Microsoft® Front Page installed on your computer.

This exercise uses HomeSite.

To create an HTML file

1. On the desktop, double-click the Microsoft Word desktop icon, or on the taskbar click the Start icon, and then select All Programs. From the list, click Microsoft Office Word. A new document named Document1 is created.

2. From your My Documents directory, select CreateNewDoc.doc.

   - The text you previously created, Using Microsoft Word you can conceptualize, write, edit, and then print your document. is displayed.
   - Press ENTER twice to start a new paragraph.
   - Enter: You can also save your documents in HTML format for publication on the web, and then edit the document in HomeSite.
   - Save your document.

3. Prepare your document for HTML.

   - On the File menu, select Save As to display the Save As dialog box.
   - Microsoft Word should default to the My Documents directory.
   - At the bottom of the screen in File name, enter the title CreateNewDoc.
   - Beneath the File name box in Save as type, click the arrow to the right of Word Document, and from the list select Web Page Filtered, and then click Save.
• Click Yes to close the information dialog box. Your document is displayed in Word as an HTM file. Next, open your document in an HTML editor to make a revision.

4. Start HomeSite.

• HomeSite opens to a page containing HTML code. Note the two tabs at the top of the page, Edit and Browse.

• Click on the Browse tab.

• On the left of your screen, the directory tree is displayed.

• Navigate to My Documents, click, and then select CreateNewDoc.htm.

• Your document appears as normal text.

• Click the Edit tab and your document appears in HTML code.

5. Now, edit your document.

• In your first paragraph, use your cursor and highlight the word "write", and then enter create. It replaces the word write.

Note: For short documents you may also highlight your document while in Microsoft Word (or a portion of your document), then cut and paste into HomeSite.

6. Save your document in HTML, and then exit HomeSite.

7. In Windows Explorer, navigate to the My Documents folder.


Adding more text and graphics to a web page can be done in Microsoft Word or in an HTML editor. If you are familiar with inserting graphics in Microsoft Word, complete the process, save as an HTM file, and then view in an HTML editor.

In this exercise, you saved an existing document into HTML, made revisions, and saved it again.